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Feature:
Supported Models:

BF6264B BF7264B BF7264B+ BF7264 Pro
[ ] [ ] [ ]
BF7264B/B+/Pro has two USB holes at the front.

In addition to the host can continue to use the predecessor, BF6264B, functions, the
newly added MIPI D-PHY analyzer function.

Specifications:

1. BF7264B/B+/Pro, 32Gb RAM, MIPI D-PHY probes

BF7264B Device

MIPI D-PHY
Way Station

Micro USB 3.0

2. supports D-PHY V1.2
Up to 2.0Gbps per lane, 1 + 4 Lanes

Y
=,

Application 0 =

grotocol 512 DSI-1

\ A )

Physical
Standard
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CSI-2 1.3 or DSI 1.3 protocol packets displayed as below with the DSI DCS
1.3 commands

Timestamp (hemss. ms.vs.ns dur)  Mode VC Data Type DCS () WC  Daw () Transaction Type  ECC () CRC ()
10 10.637.049.6.. |LP (LPDT) |0 |Generic Long Wri.. 2 |B0 03 Host proces..|00 (OK) |[F84D (OK)
11 10.637.060.1.. [LP (LEDT) |0 _|DCS Short WRITE,..|53 (write control display) 24 Host proces..|08 (OK)
12 10.637.066.5.. |LP (LPDT) |0 |DCS Short WRITE,..[35 (set tear on) 00 Host proces..|2F (OK)
13 10.637.083.3.. |[LP (LEDT) |0 |Generic Long Wri.. 2 [B0 04 Host proces..[00 (OK) [BCE2 (OK)
14 10.637.105.0.. [LP (LEDT) |0 |Generic Long Wri.. 3 [EB 00 83 Host proces..|1A (OK) |[AFAT (OK)
15 10.637.124.2.. [LP (LPDT) [0 |Generic Long Wri.. 2 |FB 00 Host proces..|00 (OK) [6818 (OK)
16 10.637.179.2.. |[LP (LPDT) |0 |Generic Long Wri.. 20 |C8 01 00 04 FB FC CD 00... |Host proces..|19 (OK) |B16A (OK)
17 10.637.196.0.. |[LP (LPDT) [0 [Generic Long Wri.. 2 [Dé 01 Host proces..[00 (OK) |[EADA (OK)
18 10.637.208.6.. [LP (LPDT) [0 |Generic Long Wri.. 2 |B0 03 Host proces..|00 (OK) [F84D (OK)
19 10.637.219.1.. [LP (LEDT) |0 |DCS Short WRITE,.. |11l (exit sleep mode) 00 Host proces..[36 (OK)
20 10.837.205.4.. [LP (LPDT) [0 |DCS Short WRITE,..|29 (set_display on) 00 Host proces..|1C (OK)
21 10.870.540.9.. [LP (LPDT) |0 |DCS Short WRITE,..|51 (set display brightness) FE Host proces..[0D (OK)
2 10.870.560.9.. |[LP (LEDT) |0 |DCS READ, no par..|DA 00 Host proces..|1E (OK)
23 10.870.562.6.. |[BTA
2 10.870.571.3.. [LP (LEDT) |0 |DCS Short READ R.. E1 00 Peripheral ..[27 (OK)
25 10.870.573.4.. |BTA
% 10.897.116.1.. |HS 0 |DCS Long Write/w..|2C (write memory start) 2881 |[DC AC AR OA SA DC DE D2... |Host proces..|[04 (OK)
o7 10.897.116.1.. |HS 0 [End of Transmiss.. 0F OF Host proces..[01 (OK)
28 10.897.134.6.. |HS 0 [DCS Long Write/w..|3C (write memory continue) 2881 |CA 1B CC EC 7A 5C 55 D2... |Host proces..|04 (OK)
2 10.897.134.6.. |HS 0 [End of Transmiss.. OF OF Host proces..|01 (OK)
30 10.897.153.2.. |HS 0 [DCS Long Write/w..|3C (write memory continue) 2881 [CA FD C2 CF F1 B0 3B 77... |Host proces..[04 (OK)
31 10.897.153.2.. |HS 0 [End of Transmiss.. OF OF Host proces..[01 (OK)
2 10.897.171.7.. |HS 0 |DCS Long Write/w..|3C (write memory continue) 2881 |3 62 52 93 5E BA 1B 77... |Host proces..[04 (OK)
33 10.897.171.7.. |HS 0 |[End of Transmiss.. 0F OF Host proces.. |01 (OK)
34 10.897.190.2.. |HS 0 [DCS Long Write/w..|3C (write memory continue) 2881 [BA 15 C3 CF E5 B8 1E 6D... |Host proces..[04 (OK)
Th 67 inn 5> oo e o (R

Use 32Gb RAM as the buffer to stream all D-PHY data into the SSD HD in

order to record all data flow from Low Power Mode to High Speed Mode
Recordable data without streaming into the SSD HD:

, Recordable
Resolutions Note
frames

1K (FHD 1080x1920) ~500

2K (WQHD 1440x2560) | ~280

8 lanes or 4 lanes with DSC
4K (UHD 2160x3840) ~120 ]
compression

8K (4320x8192) Not available | Not available

“Data Filter” filters unwanted video data to save memory

“Search” searches specific data

“ECC/CRC Packet” displays and counts ECC and CRC

Display DSI(CSI) image data including RGB, YCbCr, RAW format or
compressed DSC packets, and count the Porch from raw data. For more

information, please refer to Appendix 2.

Acute Technology Inc.
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|aa Video Display Dialog
| Image | Porch
|

Display Settings

Type [24vit RGB 8-8-8

Width [1080

Height [2340 :

4 € /3 > Dl

5]
M

-
3

 ESave Image
L

R-G-B Order [RGB &}
i1 Pause B stop
Information
Width = 1080
Height = 2340
|- Exit
\aa Video Display Dialog
Image ‘ Porch ‘
P ¥ Image_1
Image_2 v VSA y
Image_3 BLLP-1  Duration
Image_4 AVG 0 9.34us
Image-S MIN 0 9.33us
s _6 MAX 0 9.35us
ge_ » LINE
Image_7 ~ VBP
Image_8 BLLP-1  Duration
Image_9 AVG
Image_1 0 MIN 0 0.00ps
Image_11 MAX 0 0.00ps
Image_12 LINE
Image_13 Ech ; :
lnade 14 HBP Pixel HFP  Duration
9€_ NG 32 3240 0  93dus
Image_15 MN 32 3240 0  933us
Image_16 MAX 32 3240 0  935us
Image_17 » LINE
Image_18 v VFP
Image_19 BLLP-1  Duration
Image_20 QYS g gg;“s
.33us
:mg:—g; MAX 0 9.25us
! » LINE
Image_23
Image_24 |
Image_25
Image_26
Image_27
Image_28
Image_29
Image_30
Image_31
Image_32 =l (=l ] I

J&e—

VFP

[ Save CSV

Duration

BLLP-1

LP-11 or Blanking Packet

BLLP-1

LP-11 or Blanking Packet

BLLP-2 + HFP
LP-11 or
Blanking

Packet

BLLP-1
LP-11 or Blanking Packet

9. D-PHY command statistics include numbers of packets, individual command,

different data length, and errors

|- Exit

Acute Technology Inc.
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10.D-PHY command trigger

Discription Txns Bytes Statistics Txns Bytes =
» Sampled Bus Error 2455 5E (set CABC... 1 1
» DSI Error Report 0 55 (write_pow._.. 2 4
~ DSl Bus 53 (write_cont... 1 1
VC 0 1044640 29739051 35 (set_tear_on) 1 1
VC 1 18 37 11 (exit_sleep_... 1 1
VC 2 245 493 29 (set_displa... 1 1
VC 3 499 628 51 (set_displa... 1 1
BTA 14 DA 1 1
Data Type 1044899 29740212 2C (write_me_.. 407 22385
DCS Command 521835 28694276 3C (write_me... 521293 28670727
Packet Count 1044900 20 (exit_invert. .. 3 129
78 2 86
1E 2 86
60 2 44
80 1 43

a. Trigger parameters include commands and 32 bytes data in order to cover all

short packets and most of non-video long packets.
Short Packet: 4-bytes Header
Long Packet: 4-bytes Header + 28-bytes Data
b. CRC/ECC error trigger

c. The Trigger-Out port is to trigger a DSO to capture waveforms

11.TE channel detect (Tearing Effect)
¥ Tearing Effect Signal

1.8V (From Channel AQ)

*Additional LA-Probe is required

Detect the TE signal from the screen. Must purchase LA Probe to use this

function.

Please refer to Appendix 1 for details.

Acute Technology Inc.
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FAQ
Q1. What MIPI DSI version is supported, any limitation for differential ports?

A: D-PHY V1.2, up to 2.0Gbps per lane, 1 + 4 lanes.

Q2. Is C-PHY supported?

A: No. Not now or in the future.

Q3. Is DSI-2 supported?
A: No, DSI-2 includes C-PHY signal which is not supported in this solution,
the VDC-M image compression/decompression in DSI-2 is also not

supported.

Q4. Will signal quality be affected while measuring?
A: Yes, that is why the end-tips and the SMPM coaxial cables are used to
minimize the

affections of signal quality.

Q5. Is Tx supported?
A: No.

Q6. How to connect the probes with the BusFinder?

A: The BusFinder can only use the Slot-B to connect the D-PHY probe. Please note
that the two USB slots on the front of the BusFinder also need to be connected to the
Way Station. The upper USB slot corresponds to the Top Way Station, and the lower
USB slot corresponds to the Bottom Way Station. Then turn on the software, choose
the D-PHY DSI/CSI, and pay attention to whether the two road station lights have red

and green lights on.

Acute Technology Inc.
Copyright©2024.12



Acute.

PC-based T&M Instruments

[ .
¥,
Sk
:
Q

Acute Technology Inc.
Copyright©2024.12



Acute.

PC-based T&M Instruments

Q7. How to connect the probes with the DUT?
A : ®Weld the DUT:

FPC End-tip:

(Do not bend excessively to avoid internal open circuit of the FPC)
The welding line MUST be < 5mm. On the DUT, you are highly recommended to weld
a 100Q resistor and connect it to the End tip with a 3cm line.
Step 1: Connect the SMPM-SMPM cable to the End-tip first.
Step 2: Weld the End-tip to the DUT after Step 1.
% End-tip R1/R2 resistor is 1kQ/0402 which can be replaced if it breaks.

Resistor
RZ fF
Rl o

Solder R1, R2 to the corresponding resistor in the table, and C1 to the corresponding
capacitor, and follow the PCB End-tip steps to complete the connection with the DUT
CLK FPC End Tip

< 800Mbps
;:;
os
R2:1kQ
>= 800Mbps
Standard R1:500Q
C1:1pF
R2:1kQ

Acute Technology Inc.
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@User-tip : User can design his own End-tip with 1kQ resistor to connect the DUT,
then
use the 50Q impedance PCB trace to plug the SMPM connector.

@ Breakout: User can design his own EV board with the SMPM connector to connect
Acute
MIPI D-PHY analyzer by breaking out the D-PHY host and device on the PCB
board as the

chart below. R1/R2/R3 must be as close as possible by using 50Q impedance.

R1 R2 i
Host 2210 2210 Device

AW AM——»
L i
GND GND
R3
511 O

D-PHY Analyzer GND

Q8. Use multimeter to check the short circuit.

After connections as below.

Check point A: End-tip resistor front to ground, green line ==> no sound from a

multimeter.

Acute Technology Inc.
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Check point B: End-tip resistor back to ground, red line ==> sound from a
multimeter, any short circuit?
A sound from a multimeter at point B is normal because it is low impedance of
50Q) at the resistor back. So, there is no short circuit if the resistor front of 1.05
KQ without any sound.

Q9. How to connect the ground?
Two ways to connect the ground: End-tip or Way Station. (It is better connect the
End-tip ground to the DUT ground to have the better quality; but the user may the
use to Way Station ground for convenience but to have lower quality signal.)
Since the device and the system under test still need to share the same ground,
you can first connect the GND Port on the Way Station to the GND of the object
under test. Both Way Stations must be connected.
Unless the signal quality is too poor or the interference is too large, and many

errors occur after analysis, the best effect can be achieved by connecting each

End-tip to ground, as shown in the red circle in the figure below.

Acute Technology Inc.
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(Please solder the GND of the DUT directly to the connector at the end of the
End-tip.)

Q10. Is DSI/CSI Data Type or Data trigger supported?
A: Yes, Data Type, DCS Command and Data trigger are supported by BF7264.

| B8 Protocol Settings X |

é?sB;seﬂS Lane Number ‘4 Lanes E] ITrigger on
g:"u Probe Connection ECC Error (Single-bit Error)
DP-AUX Physical Connection ECC Error (Multi-bit Error)
eDP
&MMC 5.1 e CRC error
eSPI External Trigger In
HID_I2C DO%I ’
12¢ MIPI D-PHY oo-| * [D0 [*] | v osipacket &
128 H D1+ | + L=
LIN way Station D1-| u {4 DSI Trigger Settings ? X
MDIO g g CLK+
L =8 i Transmission Type  |HS or LP ||
MIPI CSI =
Y Direction @ Host Sourced ) Peripheral Sourced
MIPI I3C GND DataType [XXh,Any Host Sourced Data Type B
MIPI RFFE oy [ B
MIPI SPMI DCS XXh, Any DCS
Modbus MIPI D-PHY o2 | * [2
NAND Flash Way Station D2°| : 03 ~Header
g?f'.?éfs B ve/oT [ayve  [o][on \
-l
PWM S | |oaao [0t ]
SD 3.0 = (
SD4.0 Tearing Effect Signal | Datat | X0t l ‘
SGMIil | Ecc [ ]
SMBus
2\3:0 1.8V (From Channel paia
UART Byte 0-3 (o [ |[roen | 1
USB 1.1 *Additional LAPro| /¢ 47 o Jexn J[oom e \
USB PD Byte 8-11 [3om |[om o Jon |
- Bye 12-15 [0 [ox o [0 |
v Enable : capture for v (Beta) BvaAB0 ‘ == ” = ” o ” 8 ‘
Note: The timing information between lanes is not correct!
Byte 20-23 [0 2o [[oxr [0 ]
Byte 24-27 XXh XXt XXh XXh
Default ' [ ” ” “ 1
— Default ¥ OK X Cancel

Q11. Is that possible to setup a HS, LP or DCS command as a start condition
and then
capture data within specified time range?
A: Yes, after setup the HS, LP or DCS in the trigger settings as start condition,
move to
Configuration and change the operation mode to Protocol Monitor mode, then

you can specify the required capture time range.

Acute Technology Inc.
Copyright©2024.12



Acute.

PC-based T&M Instruments

[2] Acute BusFinder

File | Capture | Cursor

= W |Search Al Field J— DH E
R 2 ) [ B @
Connect | Protocol |Configuration § Mo Support Waveforms Run ‘0“35"”‘ ‘ NV To bottom | Window, =~ Save
Timestamp (h:ms. ms.us.ns du] |§‘ Configuration Settings 53

Operation mode

© Protecol analyzer

BusFinder memory limitation
mmms DATA i

=

C Protecel logger O Wait for Stop

‘/ Y @ Wait for Trigger

K (=

_--_ DATA & - Trigger Position ‘< 50% :
.

)]
= When Triggered
© Fill device memory then stop
I ) BeE el e i I ) Stop immediatel
I-D Wait for |15 |2 seconds then stop I
D
DATA
Default v OK % Cancel

Appendix 1: Tearing Effect Signal
Tearing Effect (TE) pin signal detect.

u

v

U

A oo™ A A

M4.00ms A S 920mvVv

v —7.76000ms

(Image Source: https://blog.csdn.net/kris_fei/article/details/77775553)

The TE pin is used by the display to inform the Host. At present, the data cannot be
updated during the screen graphics drawing. If the screen is updated when TE = High,
a horizontal break line will appear on the image. This function can clearly identify the
failure to follow TE state operation instructions, reduce the time required to guess the
problem and set up an oscilloscope to verify

The TE function requires the user to purchase an additional set of LA Probe to support
it. The default input is from channel 0, which supports two operating voltage modes of

Acute Technology Inc.
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3.3V and 1.8V. The setting is as follows,

Protocol Settings X
1B?gsaseT1S Lane Number [4 Lanes El Trigger on
% Probe Connection ol -
DP-AUX Physical Connection . ECC Error (Single-bit Error)
DP
:MMC 51 i | ECC Error (Multi-bit Error)
eSPI
HID_I2C DO+ | CRC error
gg MIPI D-PHY oo-| : [0 >
D1 =
LN Way Station )*| : o ~)  ExtemalTriggerin
MDIO e ClK+
Mil 28 K- | DSI Packet &
MIPI CSI =
MPIDSI | L
m:g 13C i | Filter Data >
MIPI SPMI 534 !El 148 bytes
o MIPI D-PHY o:-| * [0z R _
NAND Flash % -
PMBus Way Station [2*| : o3 <]  ClockRate Auto :]
m"“s e TCLK-SETTLE | Auto 2|
SD3.0 §g Phase
Sl = - 5o 0 2
|| Tearing Effect Signal
SMBus : = o 0 3
SPI
SVID D2 0 2]
UART E.BV (From Channel AQ) EI
UFS D3 [0 4]
USB 1.1 &
USB PD *Additional LA-Probe is required CLK |0 B
Phase Adjustment...
| Enable Waveform capture for connection verification (Beta)
" Default v OK % Cancel
K
Result:

{ __15:25:57.343.0HS |0 [Endof Transmiss_| | _ Je61e _____________ eost >Dev3a(Re.| | 151 | |
J 15:25:57.343_ a5 |1 |DCS Short WRITE,_|3C (veitememory.| _J21 [Host >Dev_for (Re| | 1 [changing | |

15:25:57.345. [AS |2 loeneric READ, mo_| | 64 80 ' [Host —> Dev_[oF (Re-| | 1 [changing f |
| 15:25:57.347. 85 0 syncEvent, Myl | _[ii4c st >pev.o(Re] | 1f1 I |

| 15:25:57.353.. /65 |2 |Gemeric mEAD, 1 .| | 8016 JHost -> Dev_|3A (Re.] [ 140 _ |

=S5t ns |2 smei D Rerip = LoDl [HosT o DEvS]odnGRenl il

15:25:57.356.. A5 |3 [Generic mEAD, 2| |  [eE 63 Host > Dev_[1A (he.| | 1 [changing || |

s
[}

Acute Technology Inc.
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Appendix 2: Video Display Dialog
Click Window-> Video Display Dialog to open the video display dialog,

File | Capure | Cursar
g [ fnng ren Al Fisia ’d %
B DRfeY S 3 v 58 —
Connedd | Profocol  Protocal Analyzer o Support Wavefoms. Run ear AV Tobofhm  |Windowe  Save to fext -
“ RepotList . a8
VC Data Type ocs () WC Data ( ‘Show Both Report e m  cac m) Fkt. No.  Information S —
1 Snow Stow 25+ Captuce » Sampled . 10991
F] 0 |OCS Shore WRITE, no _ |11 (swic_sicep_mode) o0 Ehom Show Secondary Report Reoot e (o) 1 » DSIEmoe . 0
5 T [cs Shore WertE, me |35 (eer dispier ow 5 = on T .
N 0 |sync Event, v Syne S o0 00 7 (oK) 1 =
5 T [sync Event, § Syne S o0 o0 3 1
5 o |svnc Event, & svac s. o0 00 Davice | 1z (o0 1
i 0 [sync Event, B Syne 5 0 00 Device | 12 (oK) 1
£l o [sync Event, B svac 5. o0 00 Device | 12 (08) 1
£ 0 |Sync Event, H Sync S_ 00 00 Device 12 (0K) 1
0 T 0 [Syac Event, E G0 00 > Device | 12 (0B) T
i T1:48:18.116. 64L_|HS 0 [Syne Evens, B G0 00 Device | 13 (0% T
n 15.316.64L s T [Hull Facket, T [ Device | 13 (oF) | F87 (oK) =
) Ti:38:15.116. 64185 G [meil packer, T [oo Device | 15 (oK) | 0Far (oK) 3
u 15.31c 641 |88 T [Wail Facket, PR Device | 13 (oR) | oFa7 (om) [
15 1a:8:15. 216, 61 |5 o [weir packar, T Joe Davice | 13 (oR) | 0re7_om B
18 15.11€.641.. |[BS 0 [Wull Packet, 1|00 Device 13 (OK) OFB7 (O} €
n 13:48:15.116.641_ |65 o [mail packst, 1 Jos Device | 13 (oR) | ore7 (oRI 7
" 15.116.642 |85 0 [Hull Packer, 1 Joo Device | 13 (0K) | 0F87 (oK) 8 =]
[ LAtiis e 83 o[BIt packs. o0 Device | 15 o | oreT o f il Josl
£l 15,116, 622_[8s 0 [Hull Packer, T [oo Device | 15 (oK) | 0F87 (oK) o e = =
a1 T3:48:15.116. 642 |85 G [Wall Packet, T [oo Device | 13 (oK) | GF87 (oK) vy
@ 15.116.642_ [ G [Huil packer, T [on Device | 15 (o%) | o1 (om) 2
2 S T [Wail Facket, T [ Device | 13 (oR) | rar _(om) )
2 s o [wair_packer, T [oo Device | 13 (or) | orev_om =
E5 & T [Wail Facket, T [ Device | 13 (oR) | 087 (oK) 15
= Bs o [mail Fackat, 1 Jos Device | 13 (oR) | ore7 (oRI 16
n HS 0 [Wull Packet, 1 |00 Device 13 (OK) OF87 (OK) 17
= Bs 0 [Wull packer, 1 Jos Device | 13 (oR) | 0Fer (oRI 18
® s 0 [Wull Packer, T oo Device | 15 (0F) | 0F87 (o) )
F 15.116.642_[us O [Wall Packet, 1o > Device | 13 (oK) | 0F87 (oK) E)
Hl 18,116, 622_[Hs O [Bull packer, T [oo Device | 15 (oK) | o7 (oK) Ty
2 15.31¢.642_ 5 T [Wail Facket, T [ Device | 13 (oF) | Fa7 (oK) =
£ 15,316,642 s o [muil packer, T [oo Device | 13 (oK) | oFar_(om) )
i & T [Wail Facket, T [ Device | 13 (oR) | ors7 (oml B
5 s o [meir Fackac, 1 [oo Device | 13 (oR) | ore7 (omI s
] 15,116,642 [R5 0 [Wull Packer, 1 |oo Device | 13 (oK) | 0Fe7 (oM 26
a 15.116.642. [0S o [mail packst, 1 Jos Device | 13 (oR) | oFe7 (oRI =
= 15.11€. 642 |HS 0 [Hull Packet, 1 |00 Device 13 (0K) OF8T (OK) 28
» 1511662 |85 o [wart packer, 1 o0 > Devics | 19 om) | orer_om = 7- (ol
al I a Dewl | Naviguior | Hile lema
a4 Video Display Dialog X
Image | Porch
Display Settings 4 Save Image
Type 24bit RGB 8-8-8 :| <4 oo P | i = -
[t
Width 1080 :I
Height 1920
R-G-B Order R-G-B
Show partial npdate
’ Process Stop
Information
|- Exit

Please set the DSI, CSI format, resolution, RGB order, and then press Process to

restore the image. Partial analysis function is also provided. If the DUT only updates

part of the screen, this option can be checked to display part of the updated content.

Acute Technology Inc.
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Example:
a4 Video Display Dialog X
Image | Porch
Display Settings 1 Save Image
Type 24bit RGB 8-8-8 -] M € 213 > Pl B [
=
Width [ 1080 M
Height [ 1920 :l
R-G-B Order [RGB M| /I ; . 4 i ; ,
1818 28
CEESAHRA
Show partial update
@ an
RS SIM =
TR N
() ToucH 1D
;& (b iPhone £ 5 Touch ID «
P Process Stop
Information
Width = 1080
Height = 1920
I Exit

It also provides a linkage function with the data in the main report area, making it easy
to find the location of the image data.

Save Image can output the restored image as .jpg / .omp / .bin.

If DSI transmits image data in Video mode, there is also a Porch function that can
count the format sent by each image. Ex: VSA, VBP, VFP, HBP, HFP, image.

If you choose TYPE-DSC restore, please select DSC Command mode use DCS
Command.

If you use V-Sync / H-Sync format, please select DSC Video mode. Specify the PPS
file (format .txt) to restore. PPS will also be replaced with the Picture Parameter Set

(OA) command.

Acute Technology Inc.
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Appendix 3: Unable to Measure / Only Measure the LP Mode Signal /
Too Many Errors Solution:

Step 1: Please check whether the 2 USBs between the probe and the BudFinder are
not connected well.
* Unplug the USB of the host device and that of the WayStation, then plug it

back in.

Step 2: Please check if the Lane/CLK wire is within 5mm of the regulation, and make
sure that each end-tip is connected to Gnd.

Step 3: Turn on the waveform viewing function and send out the HS signal to make
sure the connection is correct.

Step 3.1: Enable Waveform capture for connection verification (Beta)

[ Protocol Settings X
10BaseT1S
ase Lane Number 4 Lanes ~] Tigger on
CAN Probe Connection
DALl ECC Error (Single-bit Eror)

DP-AUX Physical Connection

eDP Multi-+
eMMC 5.1 | ECC Error (Multi-bit Error)
SPI
HD, ¢ ooe| | CRC error
12" MIPI D-PHY oo-| * D0 [
128 Way Station 2| : Dt [ External Trigger In
UN e
uoo gg o DSI Packet &
MIPI CSI =
MPI Fiter Data >
MPI 13 ono |
MIP| RFFE 3 Tmz’s“ .
MPI SPMI 3« iming Setu
Modbus MIPI D-PHY oz * D2
NAND Flash Way Station [)°|: D3 S ko
PMBus 3 TCLK-SETTLE Auto
Profibus 2G
PWM gs Phase
SD30 = D0 0
SD40 Tearing Effect Signal
SGMII D1 0
SMB —
s e oo Chanrial El D2 0
SVID ERESII AN N o -
e
UFS K 0
USB 14 ‘Additiona | LA-Probe is required
UsBPD Phase Adjustment
V' Enable Waveform capture for connection verification (Beta)
Note: The timing information between lanes is not correct!
Defauit v 0K % Cancel

Step 3.2: Switch the “Configuration Settings”. Use the “Protocol Monitor mode” and
limit the memory to 1-3%. If the problem is solved, switch back to “Protocol Analyzer

mode”
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File ‘ Capfure ‘ Cursor

Waveforme Run

Protocol | Configuration

W . [searchailField !
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Search “\ Vv |— Tobottom | Windows | Savet

WC  Data (h)

Connect
Timestamp (h:m:s.ms.‘uodz \vc ‘Data Type ‘DCS (h)
L Configuration Settings X -
Operation mode
O Protocol analyzer
v Device memory limitation
DATA T
- - e
g = )
© Protocol logger ) Wait for Stop
4 y @ Wait for Trigger
. L
KIS 2 L g . Trigger Position | < 50% :]
Wavef — ‘When Triggered
UG @ Fill device memory then stop -
@ Protocol monitor St s
0p immediately 23
© Wait for |1 seconds then stop
4 D0
© Defauit ~ OK % Cancel
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Step 3.3: Show Waveforms

File | Capture | Cursor

B W - [Search All Field :
<.  Bus | o MH Ls | DY
Connect | Protocol  Protocol Monitdr | Show: Run ‘ [Seach  JA W 4
| Hide Waveforms I
Timestamp (h:m:s.ms Model |, chow Waveforms [ oes m Wwe b
i | r——]

4

Vaveform
imefDiv = 10ns, g

EERS
MIPI DSI

Step 3.4: Capture the waveform

Step 3.5: Analyze whether there is an HS signal. Before the red arrow is the LP signal,
and after the waveform is the HS signal. (At the position of the red arrow, the LP
signal of P/N becomes low, and HS starts to have signal.) Please find a similar
position and zoom in to view the waveform. If the collection is repeated many times,
the intersection of LP and HS still cannot be found. The Lane/CLK may be

disconnected. Please refer to the FAQ 7.

Waveform =]

TimefDiv = 20 us, ]

-256ms 288 ms -254ms 252ms -25ms 248 ms 245 ms 244ms -242ms 24ms 238 ms 23 ms -234ms 232ms 23ms 228ms;

B I
[T [

4D0

EENEEERANEENEN —
. | I RERRNRERRRREEI

w51 [

LI EELd
A

s EEEEEE NN

==

MIP| DSI
CLK HS

Eoﬁx
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Label Channel

Step 3.6: Confirm whether the CLK Duty is 50:50, and check the width of each edge of
Lane 0-3 behind HS SYNC. Normally, it is the width of half a CLK cycle or

multiple. If it is abnormal, please check whether the bonding wire meets the

requirements again. If it meets the regulations, there will still be noise or CLK
Duty problems, please continue to shorten the wire length, and need to use
the GND closest to the signal.

Ex: Bad CLK duty, 65:35, 1.4ns:0.8ns

Waveform

Tene/Div =2 ns,

s Smc 1D |

Ex: The width of high pulse in Lane 0, Lane 3 is not the width of half CLK cycle
Half CLK cycle = (1.4 +0.8)/ 2 =1.1 (ns)

Under normal conditions, the width is about 1.1ns or multiple.
Waveform _ﬂ

(CCEr T — ¥
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Appendix 4: List of restored images

1. Video mode - 1125 * 2436

17 10

RE 1%
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2. CMD mode — 1125 * 2436
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